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ual describes detailed instructions on the operation and notes about the use of this machine
aximum versatility from this machine all operators are requested to read this manual carefully
w the instructions. Please keep this manual in a handy place near the machine.

t

 of this manual are subject to change without prior notice. In no event will the company be
 direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
machine.

rks

t®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
ates and/or other countries.
nd PostScript® are registered trademarks of Adobe Systems Incorporated.
, Apple, Macintosh, Mac OS, Mac OS X is a registered trademark of Apple Computer, Incor-

duct names used herein are for identification purposes only and might be trademarks of their
e companies. We disclaim any and all rights to those marks.
er names of the Windows operating systems are as follows:
roduct name of Windows® 95 is Microsoft® Windows 95.
roduct name of Windows® 98 is Microsoft® Windows 98.
roduct name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).
roduct names of Windows® 2000 are as follows:
soft® Windows® 2000 Advanced Server
soft® Windows® 2000 Server
soft® Windows® 2000 Professional
roduct names of Windows® XP are as follows:
soft® Windows® XP Professional
soft® Windows® XP Home Edition
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Notes:

Certain 
product names of Windows ServerTM 2003 are as follows:
osoft® Windows ServerTM 2003 Standard Edition
osoft® Windows ServerTM 2003 Enterprise Edition
osoft® Windows ServerTM 2003 Web Edition
product names of Windows NT® 4.0 are as follows:
osoft® Windows NT® Server 4.0
osoft® Windows NT® Workstation 4.0

options might not be available in some countries. For details, please contact your local dealer.
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ing set of symbols is used in this manual.

ING:
ol indicates a potentially hazardous situation that might result in death or serious injury when
e the machine without following the instructions under this symbol. Be sure to read the in-
, all of which are described in the Safety Information section.

ION:
ol indicates a potentially hazardous situation that might result in minor or moderate injury or
amage that does not involve personal injury when you misuse the machine without following

ctions under this symbol. Be sure to read the instructions, all of which are described in the
ormation section.

ements above are notes for your safety.

tant
ruction is not followed, paper might be misfed, originals might be damaged, or data might be
re to read this.

ration
ol indicates information or preparations required prior to operating.

ol indicates precautions for operation, or actions to take after abnormal operation.

tion
ol indicates numerical limits, functions that cannot be used together, or conditions in which

ar function cannot be used.
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at appear on the machine's display panel.

d buttons that appear on the computer's display.

ilt into the machine's control panel.

 the computer's keyboard.
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ing PostScript 3

g up Options

mentation describes the specific printer functions and menus that are added by installing the
For more information about the functions and menus of the Windows 95/98/Me PostScript

iver, see the printer driver's Help.

ration
cintosh, Mac OS 8.6 or a later version, or Mac OS X 10.1 or a later version is required. Mac
lassic is also supported.

tion
use Mac OS X, the following functions cannot be used:

ple Print

ked Print

r Code

OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the version, [Features x]
layed as [Set x] (x is a number). Make adjustments according to the version you use.
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Window

Window

Window
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Mac OS
ype

 to select the type of print job.

owing table shows the tabs or menus where you can select this function.

 select the following items:

al
ct this for normal printing. The print job starts immediately after the print command is given.

ote
nder Windows 95/98/Me, if you want to use an User ID, click the [Detail] button.

ple Print
this function to print only one set of a multiple print jobs.
other sets are saved in the machine. The saved job can be printed from the machine's control
l. You can also delete the saved job.

s 95/ 98/ Me [Job Type] on the [Setup] tab.

s 2000/XP, Windows Server 2003 [Job Type] on the [Job Log] tab in the Printing Preferences dialog box.

s NT 4. 0 [Job Type] on the [Job Log] tab in the Document Defaults dialog box.

[Job Type] on [Job Log] in the print dialog box.

 X This function is not available.
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imitation
o use this function, the optional Hard Disk Drive must be installed on the printer.

ote
he "User ID" can consist of up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

ntering the "User ID" helps you to distinguish the print job from others.

eference
or more information about how to use Sample Print, see p.10 “How to Use Sample Print”.

ed Print
this function to save documents in the machine memory with a password, and then edit and print
 as you want.

imitation
o use this function, the optional Hard Disk Drive must be installed on the printer.

ote
he "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The "Password"
ust be four digits.

eference
or more information about how to use Locked Print, see p.13 “How to Use Locked Print”.
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Use Sample Print 

the procedures to print a document using the "Sample Print" function.

 application has a collate option, make sure that it is not selected before sending a print job. By
ult, sample print jobs are automatically collated by the printer driver. If the collate option is se-
d in the application print dialog box, more prints than intended may be printed.

ws 95/98/Me

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties to set Sample Print.

k to select the [Setup] tab.

ct [Sample Print] in [Job Type].

k [Details...].

r the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
acters.

ote
elect this to identify the user associated with the job.

k [OK].
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If no
ws 2000/XP, Windows Server 2003, Windows NT 4.0

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties to set Sample Print.

k to select the [Job Log] tab.

ct [Sample Print] in [Print Job].

r the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
acters.

ote
elect this to identify the user associated with the job.

k [OK] to close the Printer Properties.

t printing from the application's print dialog box.

Sample Print job is sent to the machine and one set is printed.

ck the sample print to confirm that the settings are correct.

 settings are correct, see "Printing the Remaining Sets" in the Client Reference.

t, you can delete the saved job. See "Deleting a Sample Print File" in the Client Reference.
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 an application, select the menu command to print.

print dialog box appears.

k to select [Job Log] from the pop up menu.

ct [Sample Print] in [Job Type], and then select the appropriate setting.

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
acters. 

ote
his is used to identify the user associated with a job.

he "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

r making all of the settings you want, click [Print].
Sample Print job is sent to the machine and one set is printed.

ck the sample print to confirm that the settings are correct.

 settings are correct, see "Printing the Remaining Sets" in the Client Reference.

t, you can delete the saved job. See "Deleting a Sample Print File" in the Client Reference.
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the procedures to print a document using the "Locked Print" function.

 application has a collate option, make sure that it is not selected before sending a print job. By
ult, locked print jobs are automatically collated by the printer driver. If the collate option is se-
d in the application print dialog box, more prints than intended may be printed.

ws 95/98/Me

 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties to set Locked Print.

k to select the [Setup] tab.

ct [Locked Print] in [Job Type].

k [Details...].

r the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
acters. Then enter a password in [Password], up to four digits.

ote
elect this to identify the user associated with the job.

k [OK].
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 an application, select the menu command to print.

print dialog box appears.

n the Printer Properties to set Locked Print.

k to select the [Job Log] tab.

ct [Locked Print] in [Print Job].

r the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
acters. Then enter a password in [Password], up to four digits.

ote
se this to identify the user associated with the job.

k [OK] to close the Printer Properties.

t printing from the application's print dialog box.

Locked Print job is sent to the machine.
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 an application, select the menu command to print.

print dialog box appears.

k to select [Job Log] from the pop up menu.

ct [Locked Print] in [Job Type], and then select the appropriate setting.

r the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
acters. Then enter a password in [Password], up to four digits.

ote
his is used to identify the user associated with a job.



16

Collat

Use this
multiple

Lim
❒ To u

print

❒ Unde
chec

• W
T
P

• M
T

• M
T

The foll

Window

Window

Window

Mac OS

Mac OS
e

 function to enable collation. With this feature, the printer can efficiently print collated sets of
-page documents.

itation
se this function, a Memory Unit of at least 128MB or Hard Disk Drive must be installed on the
er.

r Windows 2000/XP, Windows Server 2003, Mac OS, or Mac OS X, make sure the following
k boxes have not been selected.

indows 2000/XP, Windows Server 2003
he [Collate] check box on [Paper/Output] on [Advanced...] on the [Paper/Quality] tab in the
rinting Preferences dialog box.

ac OS
he [Collate] check box in the print dialog box.

ac OS X
he [Collate] check box on [Copies & Pages] in the printer dialog box.

owing table shows the tabs or menus where you can select this function.

s 95/98/Me [Collate] on the [Setup] tab.

s 2000/XP, Windows Server 2003 [Collate] on [Advanced...] on the [Paper/Quality] tab in the Printing 
Preferences dialog box.

s NT 4.0 [Collate] on [Document Options] on the [Advanced] tab in the Docu-
ment Defaults dialog box.

[Collate] on [Printer Specific Options] in the print dialog box.

 X [Collate] on the [Feature 1] tab on [Printer Features] in the printer dia-
log box.
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Print

Window

Window

Window
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x Printing

 function to select duplex printing.

itation
se this function, the optional Duplex Unit must be installed on the printer.

cannot perform duplex printing from the Bypass Tray.

owing table shows the tabs or menus where you can select this function.

 select the following items: The following items may vary depending on the operating system
using.

s 95/98/Me

bles Duplex Printing.

n to Left
s output so that you can open it to the left.

s 95/98/Me [Duplex] on the [Setup] tab.

s 2000/XP, Windows Server 2003 [Print on Both Sides (Duplex)] on the [Layout] tab in the Printing Pref-
erences dialog box.

s NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab in the 
Document Defaults dialog box.

[Print on Both Sides] on [Layout] in the print dialog box.

 X The [Print on Both Sides] check box on [Duplex] in the print dialog 
box.



18

❖❖❖❖ Ope
Print

Window

Note
❒ If yo t
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❖❖❖❖ Non
Disa

❖❖❖❖ Flip 
Print

❖❖❖❖ Flip 
Print

Window

❖❖❖❖ Non
Disa

❖❖❖❖ Shor
Print

❖❖❖❖ Long
Print
n to Top
s output so that you can open it to the top.

s 2000/XP, Windows Server 2003, Mac OS, Mac OS X

u use a Mac OS, click to select the button that means “Flip on Long Edge” or “Flip on Shor
”.

e
bles Duplex Printing.

on Short Edge
s output so that you can open it to the short edge when bound along the short edge.

on Long Edge
s output so that you can open it to the long edge when bound along the long edge.

s NT 4.0

e
bles Duplex Printing.

t Side
s output so that you can open it to the short edge when bound along the short edge.

 Side
s output so that you can open it to the long edge when bound along the long edge.
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 Mode

 to select whether the document is printed in color or black and white.

owing table shows the tabs or menus where you can select this function.

u use Windows 95/98/Me, this mode is called "Color/Black and White".

 select the following items:

r
s color documents in full color.

ote
olor images will be printed using CMYK toner, Cyan, Magenta, Yellow and Black. CMYK are
ree primary subtractive colors.

 you want to adjust the print color, adjust the settings in the Advanced dialog box accessed from
e Advanced button on the [Paper/Quality] tab.

s 95/98/Me [Color Mode] on the [Setup] tab.

s 2000/XP, Windows Server 2003 [Color Mode] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preferences dialog box.

s NT 4.0 [Color Mode] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Color Mode:] on [Printer Specific Options] in the print dialog box.

 X [Color Mode] on the [Features 1] tab on [Printer Features] in the print 
dialog box.
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Use this

Lim
❒ This

Refe
For m
k and White
s everything, including color documents, in black and white. Black and White printing is faster
 Color printing. To stop black and white areas being printed with CMYK toner, select [Black

hite] in the printer driver as well as in the application.

 Selection

ources and Output Tray Tabs

 to select the media type, input tray, and output tray.

itation
 function is for Windows 95/98/Me only.

rence
ore information about the [Paper Sources and Output Tray] tabs. See the printer driver's Help.
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 to select the size of paper you want to use.

owing table shows the tabs or menus where you can select this function.

rence
ore information about the paper sizes supported by this printer, see "Paper and Other Media
orted by This Printer" in the Maintenance Guide.

s 95/98/Me [Size:] on the [Paper] tab.

s 2000/XP, Windows Server 2003 [Paper/Output] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preference dialog box.

s NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document Defaults dialog 
box.

[Paper:] on the [Page Attributes] tab in the Page Setup dialog box.

 X [Paper Size:] in the Page Setup dialog box.
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Window

Window

Window
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 to select the paper type.

owing table shows the tabs or menus where you can select this function.

rence
ore information about the media type supported by this printer, see "Types of Paper and Other

ia" in the Maintenance Guide.

s 95/98/Me [Type:] on [All Pages] on the [Paper] tab.

s 2000/XP, Windows Server 2003 [Media:] on the [Paper/Quality] tab in the Printing Preference dialog 
box.

s NT 4.0 [Paper/Output] on the [Advanced] tab in the Document Defaults dialog 
box.

[Paper Type:] on [Printer Specific Options] in the print dialog box.

 X [Paper Type] on the [Features 3] tab on [Printer Features] in the print 
dialog box.
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Window
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 to select the paper sources.

owing table shows the tabs or menus where you can select this function.

ution

 to set the resolution to [600dpi] or [1200dpi].

itation
n the resolution option is set to [1200dpi], the gradation option must be set to [Fast].

owing table shows the tabs or menus where you can select this function.

s 95/98/Me [All Pages] on the [Paper] tab.

s 2000/XP, Windows Server 2003 The [Paper/Quality] tab in the Printing Preferences dialog box.

s NT 4.0 The [Page Setup] tab in the Document Defaults dialog box.

[Paper Source:] on [General] in the print dialog box.

 X [Paper Feed] in the print dialog box.

s 95/98/Me [Advanced] on the [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Graphic] on [Advanced...] on the [Paper/Quality] tab in 
the Printing Preferences dialog box.

s NT 4.0 [Graphic] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

[Printer Specific Options] in the print dialog box.

 X [Resolution] on the [Features 1] tab on [Printer Features] 
in the print dialog box.
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Window
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 to select a type of gradation based on your purpose.

owing table shows the tabs or menus where you can select this function.

 select the following items:

dard
s with good quality of gradation.

s quickly while gradation loses some smoothness.

s 95/98/Me [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Gradation] on [Advanced...] on the [Paper/Quality] tab in the Printing 
Preferences dialog box.

s NT 4.0 [Gradation] on [Document Options] on the [Advanced] tab in the Doc-
ument Defaults dialog box.

[Gradation] on [Printer Specific Options] in the print dialog box.

 X [Gradation] on the [Features 1] tab on [Printer Features] in the print di-
alog box.
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 Profile

 to select the color profile pattern.

owing table shows the tabs or menus where you can select this function.

 select the following items:

ortant
u use Windows 95/98/Me, you can configure [Color Profile] in [Advanced] by selecting [Manual]
 the[Color] setting. [Automatic] sets the printer to "Auto".

this setting to configure the best color profile pattern automatically depending on the appear-
 of the document to be printed.

ographic
this setting to enhance the reproduction of photos and graphics that include midtones.

s 95/98/Me The [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Color Profile] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preferences dialog box.

s NT 4.0 [Color Profile] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Color Profile:] on [Printer Specific Options] in the print dialog box.

 X [Color Profile] on the [Features 2] tab on [Printer Features] in the print 
dialog box.
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Use 

❖❖❖❖ User
Use 

Note
❒ Use 

shou
ferre :
[Auto
entation
this setting to enhance the reproduction of documents that contain text and graphics. This CRD
st for printing colored charts, graphs, presentation materials and so on. If you use this CRD for
ing photographs, the color or gradations might not be reproduced well.

 Color
this setting to print specific colors, logos and so on.

 Setting
this setting to print images with downloaded CRD from your application.

this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
ld select the appropriate CRD for the document you are printing. The selected CRD is also re-
d to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available
],[Photographic], [Presentation] and [Solid Color].
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Window
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 Setting

 to select the correction method used for color conversion.

owing table shows the tabs or menus where you can select this function.

ortant
u use Windows 95/98/Me, you can configure [Color Setting] in [Advanced] by selecting [Manual]
 the [Color] setting. [Automatic] sets the printer to "Super Fine".

color rendering dictionary that is selected in the "Color Profile" setting is used.

 select the following items:

odification to the color setting.

s 95/98/Me [Advanced] on the [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Color Setting] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preferences dialog box.

s NT 4.0 [Color Setting] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Color Setting:] on [Printer Specific Options] in the print dialog box.

 X [Color Setting] on the [Features 2] tab on [Printer Features] in the print 
dialog box.
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Note
❒ Use 
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ferre :
[Auto
ct this setting to perform color matching based on one of the printer's built- in color rendering
onaries and perform CMYK conversion. This setting performs the printing which output target
onitor γ = 1.8.

r Fine
ct this setting to use a color rendering dictionary as in the "Fine" setting but produce output that
ore vivid. Use this setting to emphasize light colors. This setting performs the printing which
ut target is Monitor γ = 2.2.

this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
ld select the appropriate CRD for the document you are printing. The selected CRD is also re-
d to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available
],[Photographic], [Presentation] and [Solid Color].
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 to set the Image Rendering mode.

owing table shows the tabs or menus where you can select this function.

ortant
 use Windows 95/98/Me, you can configure [Dithering] in [Advanced] by selecting [Manual] from
r] setting. [Automatic] sets the printer to "Auto".

 select the following items:

this setting to configure the best dithering method automatically depending on the appearance
e document to be printed.

ographic
rms dithering using an appropriate pattern for photographs.

rms dithering using an appropriate pattern for text.

s 95/98/Me [Advanced] on the [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Dithering] on [Advanced...] on the [Paper/Quality] tab in the Printing 
Preferences dialog box.

s NT 4.0 [Dithering] on [Document Options] on the [Advanced] tab in the Doc-
ument Defaults dialog box.

[Dithering] on [Printer Specific Options] in the print dialog box.

 X [Dithering] on the [Features 2] tab on [Printer Features] in the print di-
alog box.
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 Setting
this setting to print images set in half tone in your application.

Reproduction

 to select the Black Color mode for text and line art.

owing table shows the tabs or menus where you can select this function.

ortant
 use Windows 95/98/Me, you can configure [Gray Reproduction] in [Advanced] by selecting [Man

rom the [Color] setting. [Automatic] sets the printer to "Pure Black Text".

u use Windows 2000/XP, Windows Server 2003, Windows NT 4.0, Mac OS or Mac OS X, this
tion is called "Black Text/Graphics".

s 95/98/Me [Advanced] on the [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Black Text/ Graphics] on [Advanced...] on the [Paper/Quality] tab in 
the Printing Preferences dialog box.

s NT 4.0 [Black Text/ Graphics] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

[Black Text/Graphics] on [Printer Specific Options] in the print dialog 
box.

 X [Black Text/Graphics] on the [Features 2] tab on [Printer Features] in 
the print dialog box.
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 select the following items:

 Black Text
ct this setting to use a black toner.

ote
 you use Windows 2000, Windows XP, Windows NT 4.0, Mac OS or Mac OS X, this mode is
alled "K".

+K
ct this setting to use all toners.

 Over Print

hether or not to apply a black color over any other colors when printing.

owing table shows the tabs or menus where you can select this function.

ortant
 use Windows 95/98/Me, you can configure [Black Over Print] in [Advanced] by selecting [Manual]

 the [Color] setting.

s 95/98/Me [Advanced] on the [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Black Over Print] on [Advanced...] on the [Paper/Quality] tab in the 
Printing Preferences dialog box.

s NT 4.0 [Black Over Print] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Black Over Print:] on [Printer Specific Options] in the print dialog box.

 X [Black Over Print] on the [Features 2] tab on [Printer Features] in the 
print dialog box.
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 function to reduce the amount of toner used when printing.

owing table shows the tabs or menus where you can select this function.

s 95/98/Me [Toner Saving] on the [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Toner Saver] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preferences dialog box.

s NT 4.0 [Toner Saver] on [Document Options] on the [Advanced] tab in the 
Document Defaults dialog box.

[Toner Saver:] on [Printer Specific Options] in the print dialog box.

 X [Toner Saver] on the [Features 1] tab on [Printer Features] in the print 
dialog box.
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 Control

 to select whether or not you want the colors in the documents to be adjusted before printing so
printed page matches closer to the colors on the screen.

owing table shows the tabs or menus where you can select this function.

 use Windows 2000/XP or Windows Server 2003, this function is called "Image Color Manage-
t".

u use Windows NT 4.0, this function can not be configured.

u use Mac OS, this function is called "Color Matching".

e Color Control
lay the Image Color Matching dialog box, click this button to specify exactly how you want the
rs on your screen adjusted before printing.

s 95/98/Me The [Print Quality] tab.

s 2000/XP, Windows Server 2003 [Graphic] on [Advanced] on the [Paper/Quality] tab in the Printing 
Preferences dialog box.

s NT 4.0 This function is not available.

[Print Color] on the [Color Matching] tab in the print dialog box.

 X This function is not available.
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 to set a user code for print logging.

user code using up to eight digits. A user code identifies a group of users and allows you to
e number of sheets printed under each code with SmartDeviceMonitor for Admin.

owing table shows the tabs or menus where you can select this function.

rence
ore information about using SmartDeviceMonitor for Admin, see Help.

s 95/98/Me [User Code] on the [Statistics] tab.

s 2000/XP, Windows Server 2003 [User Code] on the [Job Log] tab in the Printing Preferences dialog 
box.

s NT 4.0 [User Code] on the [Job Log] tab in the Document Defaults dialog box.

[User Code] on [Job Log] in the print dialog box.

 X This function is not available.
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tting Up Options” in the Client Reference or the Administrator Reference for the installation
 appropriate to your printing environment.

owing table shows the tabs or menus where you can select this function.

 2
ou can select the tray with the following menu for PAPER FEED UNIT Type 3000:
aper Source, see p.23 “Paper source”

 3
ou can select the other tray with the following menu for an additional PAPER FEED UNIT
ype 3000:
aper Source, see p.23 “Paper source”

Note
If you use Windows 2000/XP, Windows Server 2003, Windows NT 4.0, Mac OS or Mac OS
X, this menu is called "Tray 2 and 3".

s 95/98/Me [Option] on the [Accessories] tab.

s 2000/XP, Windows Server 2003 [Installable Options] on the [Device Setting] tab.

s NT 4.0 [Installable Options] on the [Device Setting] tab in the Document De-
faults dialog box.

[Chooser] on the Apple Menu.

 X This function is not available.
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ou can use the following function with AD440:
uplex Printing, see p.17 “Duplex Printing”

 Disk
ou can use the following function with Printer Hard Disk Type 3000:
ollate, see p.16 “Collate”

Note
This function is for Windows 95/98/Me only.

l Memory
ou can use the following function with Memory Unit Type C (64/128/256 MB):
ollate, see p.16 “Collate”

ote
he optional Memory Unit of at least 128MB must be installed on the printer.

his function is for Windows 95/98/Me only.
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Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

tion
cintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

 Utility for Mac is included on the CD-ROM labeled “Printer Drivers and Utilities”.

 Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or 10.2.1. Mac OS X 10.0.x
.2 are not supported.

ling Printer Utility for Mac

ese steps to install Printer Utility for Mac on the machine.

he Macintosh.

 the CD-ROM into the CD-ROM drive.

D-ROM icon appears.

e-click the hard disk icon to open it.

e-click the CD-ROM icon.

ntents of the CD-ROM appear.

e-click the [Mac OS 8 and 9] folder.

te
der Mac OS X, double-click the [Mac OS X] folder.

e-click the [PS Utility] folder on the CD-ROM.



38

GGGG Dou

HHHH Dou

IIII Mov
erat

JJJJ Drag

Print
ble-click the [Printer Utility for Mac] folder.

ble-click the folder of the language you use.

e the “Printer Utility for Mac” file to the Macintosh hard disk using a drag-and-drop op-
ion.

 the CD-ROM icon to the Trash to eject the CD-ROM.

er Utility for Mac is installed.
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ortant
re starting Printer Utility for Mac, make sure the printer is selected in [Chooser] on the Apple
u.

ble-click the Printer Utility for Mac icon.

[Printer Utility for Mac] dialog box appears.

k [OK].
er Utility for Mac will take a few seconds to start.

eference
or more information, see p.41 “Printer Utility for Mac Functions”.
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ble-click the Printer Utility for Mac icon.

[Printer Utility for Mac] dialog box appears.

k [OK].

e [Available Printers:] box, select the printer you want to use.

ote
 you change zones, select a name from [Available Network Zones:].

lick [Choose Printer...] on the Printer Utility for Mac menu if you want to change the printer.

ct the printer you want to use.

er Utility for Mac will take a few seconds to start.

k [Choose].

eference
or more information, see p.41 “Printer Utility for Mac Functions”.
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tility for Mac functions are described below.

menu
ownload PS Fonts...]
ownload fonts (PostScript Type 1) to the printer. See p.42 “Downloading PS Fonts”.

isplay Printer's Fonts...]
isplay and delete the fonts in printer memory and the printer's hard disk drive. See p.43 “Dis-
laying Printer's Fonts”.

nitialize Printer's Disk...]
itialize the printer's hard disk drive. See p.45 “Initializing the Printer Disk”.

age Setup...]
et up the paper size to print “Printer Font Catalog” and “Printer Font Sample”. See p.46 “Page
etup”.

rint Font Catalog...]
rint the names of available fonts. See p.46 “Printing Font Catalog”.

rint Font Sample...]
rint a sample of fonts. See p.46 “Printing Font Sample”.

ename Printer...]
hange the printer's name when viewed via Appletalk. See p.47 “Renaming the Printer”.

estart Printer]
estart the printer. See p.48 “Restarting the Printer”.
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ownload PostScript File...]
ownload a PostScript File. See p.49 “Downloading PostScript Files”.

elect Zone...]
hange the zone to which the printer belongs to via Appletalk. See p.49 “Selecting the Zone”.

isplay Printer Status...]
isplay the status of the printer. See p.50 “Displaying the Printer Status”.

aunch Dialogue Console...]
reate and edit a PostScript file, and then download it to the printer. See p.51 “Launching the
ialogue Console”.

loading PS Fonts

 download the PS fonts to the printer's memory or hard disk drive.

ortant
following procedures to download the fonts assume that you are a system administrator. If you
ot, be sure to consult your system administrator.

 printer restarts, all the printer settings return to their defaults.

irm that a Macintosh and the printer are connected with Appletalk.

e fonts cannot be downloaded.

re downloading, read the documentation about the fonts you want to use.

ct [Download PS Fonts...] on the [File] menu.

k [Add to list].
dialog box to select fonts appears.
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CCCC Clic
k to select the desired font files, and then click [Open].
list of selectable font names appears.

r adding all the fonts you want to download, click [OK].
dialog box of selected fonts to download appears.

k [Download].
fonts begin to download, and the download status is shown.

portant
uring the download, do not turn off the power switch, operate the panel or open or close the
over.

n the completion message appears, click [OK].

k [Cancel].

ying Printer's Fonts

 display the available fonts currently downloaded to the printer. Fonts in the printer's memory
 disk drive can be displayed.

fonts displayed in italics are the default fonts.

ct [Display Printer's Fonts...] on the [File] menu.

alog box appears.

ct [Printer's memory] or [Printer's disk].

k [OK].
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 delete fonts from the printer's memory or hard disk drive.

ct [Display Printer's fonts] on the [File] menu.

alog box appears.

ct [Printer's memory] or [Printer's disk].

ct the fonts you want to delete.

imitation
ou cannot delete the fonts displayed in italic.

k [Delete].
nfirmation message appears.

firm the fonts you want to delete and the printer name from which you want to delete the
s.

k [Continue], and then click [OK].

k [OK].
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itializing the printer's hard disk, all the fonts downloaded to the printer's hard disk drive are
 Before initializing, be sure to check the fonts on the hard disk drive.

ortant
n initializing the printer's hard disk drive from the operation panel, all of the data on the printer's
 disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

ct [Initialize Printer's Disk...] on the [File] menu.

confirmation message appears.

ote
o cancel initialization, click [Cancel].

k [Execute].
lizing starts.

portant
o not turn off the power switch until initializing is completed, otherwise the hard disk drive migh
e damaged.

n the completion message appears, click [OK].
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 set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.

ct [Page Setup...] on the [File] menu.

ose the paper size.

ng Font Catalog

 names of fonts available on the printer.

paper selected under [Page Setup] is used.

ct [Print Fonts Catalogue] on the [File] menu.

k [Print].

ng Font Sample

 print samples of fonts downloaded to the hard disk drive or memory.

 by using the paper selected on [Page Setup].

ct [Print Fonts Sample...] on the [File] menu.

k [Print].
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ing the Printer

 change the printer's name displayed under Appletalk. If you connect several printers on the
, assign different names so you can identify them. If several printers have the same name, a digit
 next to the printer name in [Chooser].

he [File] menu, click [Rename Printer...].

e [New Name:] filed enter a new name.

imitation
ou can enter up to 31 digits and letters.

o not use symbols, for example “*”, “:”, “=”, “@”, “~”.

k [Rename].
printer name is changed.

k [OK].

 OS

n the Apple menu, click [Chooser].
lick the [AdobePS] icon.

elect the printer whose name you changed in step B, and then close the [Chooser] dialog
ox.

Note
If there are several Appletalk zones, select the zone the machine belongs to.
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n the [Printer Utility for Mac] menu, click [Choose Printer...].
 the [Available Network Zones:] list, select the zone for the Macintosh in use.

 the [Available Printers:] list, select the printer whose name you changed in step B, and
en click [Choose].

rting the Printer

 restart the printer.

ct [Restart Printer] on the [File] menu.

firm the message that appears on the screen, and then click [Restart].
printer restarts.

ote
he fonts that you downloaded in the printer's memory will be deleted.

 the printer restarts, all the printer settings return to their defaults.
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 download a Postscript file to the printer.

ct [Download PostScript File...] on the [Utility] menu.

ct the file name to download and click the file name, and then click [Open].

e the log file name, and then click [Save].
selected file is downloaded.

ote
rrors are recorded in the log file.

ting the Zone

 change the zone to which the printer belongs under Appletalk.

ortant
irm that a Macintosh and printer are connected with Appletalk.

he [Utility] menu, click [Select Zone...].
zone to which the printer belongs and the available zone list appear.

ct the zone which you want to locate the printer in, and then click [Change].
nfirmation message appears.

k [Continue].
nfirmation message appears.

k [OK].
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n the Apple menu, click [Chooser].
lick the [AdobePS] icon.

 the [Appletalk zone:] list, select the zone changed in step B.

 the [Select a PostScript Printer:] list, select the printer you want to use.

lose the [Chooser] dialog box.

 OS X

n the [Printer Utility for Mac] menu, click [Choose Printer...].
 the [Available Network Zones:] list, select the zone changed in step B.

 the [Available Printers:] list, select the model of printer in use, and then click [Choose].

ying the Printer Status

 display and confirm the current status of the printer.

ct [Display Printer Status...] on the [Utility] menu.

current status of the printer appears.

firm the current status of the printer.

 can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status
available space on the hard disk drive. You can also confirm the zone to which the printer be-
s to.

k [OK].
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 create and edit a PostScript file for printing, and then download it to the printer.

ortant
nch Dialogue Console” is recommended for users with an understanding of PostScript.

ot download any file other than PostScript files to the printer.

nch Dialogue Console” must be used at your own responsibility.

ct [Launch Dialogue Console...] on the [Utility] menu.

 the editing screen. The Dialogue Console menu bar appears.

e the PostScript command in the editor screen.

ote
o edit a PostScript file, select [Open] on the [File] menu to open it.

ou can search or replace a character string by using the [Search] menu.

r editing the PostScript file, select [Download Top Window] on [Console] menu to start print-

PostScript file is sent to the printer.

ote
he [Reply from Printer] box opens, depending on the PostScript file you sent.

ct [Return To Main Menu] on the [Console] menu to close the PostScript file.
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